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INTRODUCTION TO
Congratulations - you have just bought yourself
a photographic memory! C-Pen is a Mobile
Information Collector that reads, remembers,
processes and transfers printed text cordlessly to
your Windows-equipped PC. C-Pen is in essence
an electronic high-lighter that saves the text you
are marking. Carry it with you wherever you go!

Your Personal Digital Assistant
Make it a habit to bring your portable text
collector with you, and you are always ready to
read and save text from books, papers, brochures
or business cards. You can easily record price-
lists, timetables, wine-tips or witty quotes. You
don’t have to tear out pages any more.

Your saved text files can later be transferred to your PC. It
is also possible to use C-Pen to read text directly into a
Windows application in your PC.

Powerful features
C Read is the basic function of C-Pen. Move C-Pen

over the text, and the text will be placed in the
pen, where you can save it as a file for later
processing.

C Direct enables you to transfer the read text directly
from C-Pen into your PC. The text will be
placed at the cursor position in for instance a
Word or Excel document.
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messages, SMS, to someone’s mobile phone
or an e-mail to their e-mail account. You can
either send complete files from Notes or write
a short message with C Write directly into
C Message and then send it.

Optimum reading conditions
C-Pen uses Optical Character Recognition (OCR) to read
text. OCR is the process of turning an image of characters
into computer-readable text.

As C-Pen is moved over the text, its internal light source
illuminates the characters and a camera takes images of
the text. During the OCR, C-Pen analyzes the images taken
by its camera and translates them into text characters.

The OCR quality will depend on the reading conditions.
The most common confusions between characters with
OCR are:

e � c l � I t � c

r+n � m i � l c � o

The following conditions affect the quality of the charac-
ter recognition:

• The print quality of the text
High-quality printed text produces, of course, maximum
OCR accuracy. With lower-quality pages, e.g. fax
copies, OCR accuracy may be poorer. You can calibrate
the C-Pen to optimize its performance under difficult
conditions; see Calibration p. 76.

C Address is an application in C-Pen for storing and
looking up contact information such as
addresses, phone numbers and e-mail
addresses. C Address can be synchronized
with Microsoft Outlook and supports the
vCard standard.

C Calendar works as an ordinary calendar with the
advantage of displaying the information in
many different ways once you have the
information in your C-Pen. You can choose to
view a whole month, a single week or a day
and you can either read or write event/task
information into your C-Pen.

C Write gives you the possibility to enter characters
by writing with C-Pen as an ordinary pen.
This is useful when editing text, entering file
names, looking up words in C Dictionary or
searching for a contact in C Address.

C Dictionary is a software package that enables your C-
Pen to translate words. It is very easy to use,
simply slide your C-Pen over the word you
require translated and within less than a
second the result is displayed. Each language
software package contains a two-way Oxford
or Norstedts dictionary.

C Message sends text messages and is used in
combination with a mobile cellular phone.
With C Fax you can send fax messages, while
C SMS is used when you want to send text
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User documentation and support
There are different sources to support your use of C-Pen:

• This User Guide contains a description of C-Pen and
instructions for reading, editing and saving files. The
applications Notes, C Address, C Dictionary, C Direct,
C Write, Storage, Settings and Info are explained. You
will also learn how to connect C-Pen to a PC.

• The attached CD contains the C-Pen Windows
Software for communication between C-Pen and your
PC, as well as a Read me and an Installation help file
on how to install and configure your computer for
infrared communication.

• When using C-Pen together with your PC, you have
access to on-line help, which is automatically installed
on your PC, when you install the C-Pen Windows
Software. The help topics are mostly related to the
C-Pen Windows Software. The instructions for using C
Direct is more thorough in the on-line help than in this
User Guide.

• Visit our web site to get the latest C-Pen news and free
software upgrades. On our web site you will also find
troubleshooting, FAQ (Frequently Asked Questions)
and several language versions of the User Guide.

Care & Safety
• Keep C-Pen away from direct sunlight, heat, moisture

and dust.

• Do not expose C-Pen to extreme variations in tempera-
ture.

Please note that C-Pen only recognizes machine-printed
characters such as laser-printed or typewritten text.
C-Pen does not recognize handwritten text.

• Position and movement of C-Pen
It is important how you hold and move C-Pen over the
printed text. Please read the Quick Start folder to learn
how to use C-Pen correctly. It is crucial that you follow
these instructions in order to get the best results.

• The language of the text
See Text Language, p. 76.

• Deformed characters
Anything that is not a printed character, and any
character distorted by a mark or smudge on the paper
could be unrecognizable.

• Overlapped characters
Characters in the text should not overlap.

• Italics and underlined text
Italics are, for some fonts, difficult for C-Pen to read.
Underlined text is also difficult for C-Pen to read
because the underline changes the shape of descend-
ers of the letters q, g, y, p, and j.

• Text colors - text and surface
C-Pen cannot read some combinations of text colors on
colored surfaces, such as red or yellow text on a white
or red background.

• Small or large character sizes
The size of the characters should be 7–20 points.

!
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PRESENTATION OF THE PEN

Parts of the pen

• Make sure the camera opening is free from dust or any
other objects.

• Clean C-Pen with a dry cloth. Do not use detergents or
other chemicals when cleaning C-Pen.

• Use only 1.5 V AAA batteries of type LR03 (alkaline).

• Make backup copies of your C-Pen files regularly and
keep the copies in a safe place.

be changed to suit left-handed users. See
System Settings, p. 79.

IR port The infrared (IR) port is used for wireless
data transfer between C-Pen and a PC that is
also equipped with an IR port.

ESC Closes menus.

Charging To this connector you insert the charging
Connector plug in order to reload the battery when the

C-Pen battery level is low.

Reset If the pen seems to have “locked up” you can
gently press something similar to an unfolded
paperclip into the reset hole, see the picture
on p. 10.

On/Off Turns C-Pen on or off, when pressed for
Nav two seconds.

This button is also used as a control for
moving around in menus and texts (turn
control left or right) and to select an item or
an option (press briefly).

Display Used to display read text and for communica-
tion between C-Pen and the user.
The orientation of the text on the display can

!
Please note that the camera opening is not
protected in any way. This enhances C-Pen’s
reading ability.

Display objects
C-Pen uses the following display objects to communicate
with you:

• status field

• application icon

Camera
opening

Escape button (ESC)

IR port

Navigation control (Nav)
and On/Off button

Display
 IR port

Charging
connector

Reset

Navigation control (Nav)
and On/Off button
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Check box
Check boxes also provide different options. A check box
remains checked until you
uncheck it or check another of
the alternative boxes in the list.

Dialog box

A dialog box appears when you need to enter information
or give commands to C-Pen. A dialog box contains one or
more objects such as edit fields or dialog buttons.

Edit field
It is possible to enter and edit text in an edit field. An edit
field is recognized by its frame, see the figure above.

Dialog button
Dialog buttons are used in dialog boxes to give simple
instructions to C-Pen.

• menu

• check box

• dialog box

• edit field

• dialog button

Status field
The area on the left side of the display is called the status
field. This field displays the time, current application in
use, text settings (Text Quality and Text Language) and
C-Pen’s power level. See also Settings, p. 75 and Battery
p. 14.

Application icon
The applications are represented by application icons in
the Main screen. The applications will all be described in
the chapter Applications, p. 33.

Menu
Menus provide different options. A scroll bar indicates if
there are more menu items available above or below.

Main screen

Application icons

Checked box
Unchecked box

Text Language (see Settings)

Text Quality
(see Settings)

Power level

Time

Alarm icon
Application icon

Menu

Menu items

Scroll bar

Edit field

Dialog buttons

A dialog box

Common dialog buttons



1514

In order to recharge the battery just insert the charging
adapter’s plug to the C-Pen charging connector. The
charging adapter is included in the C-Pen package.

If the battery level is too low you get the message
“Battery level too low! Shutting down.” You must
recharge the battery to be able to continue using C-Pen.

Navigating and selecting
Nav (the navigation control) is used for navigation and to
select an object.

Turn Nav left or right to navigate between

• menu items

• dialog buttons

• edit fields

• check boxes

• lines or characters in text

As you move between objects,
they become highlighted
(inverted) one by one.

Pressing Nav briefly when an object is highlighted is
referred to as selecting that object.

The result when selecting an object is explained for each
situation later in this manual. Below are some general
remarks about selecting objects.

Press to select
an object

Turn to navigate
between objects

GETTING STARTED
Turning C-Pen On and Off
To turn C-Pen on and off, press the On/Off button until
the display is activated/deactivated.

C-Pen turns off automatically after 4 minutes of non-use.
To change the automatic power-off time, see System
Settings, p. 79.

Battery
The battery power level is shown in the battery indicator
at the bottom of the status field.

If the battery power is getting low, the message “Battery
level low” appears on the display. You should recharge
the battery to ensure that information, which is not
previously saved, is not lost.

Text Language (see Settings)

Text Quality
(see Settings)

Power level

Time

Alarm icon
Application icon

Press to turn C-
Pen on and off
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A cursor will appear in the edit field and the status field
shows the edit mode symbol. See Editing text, p. 21.

Check boxes
To mark an alternative in a list of check boxes, navigate to
the alternative of your choice:

Execute the change by selecting the alternative. The
checkbox becomes checked:

Menus
Selecting a menu item marked with a  will display further
alternatives in a new menu.

Selecting CANCEL will close the menu. Instead of
selecting CANCEL, you can press ESC.

Dialog buttons
In a dialog box you instruct C-Pen how to continue by
selecting a dialog button:

O K You accept a suggestion in a dialog box.

YES Your answer is “Yes” to a question in a dialog
box.

N O Your answer is “No” to a question in a dialog
box.

CANCEL The dialog box closes and you return to your
earlier position. Instead of selecting CANCEL,
you can press ESC.

Edit fields
To be able to edit text in an edit field you have to select it.

Menu item with alternatives

Edit field

Cursor

Edit mode symbol
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4. Lift the pen at the end of the line.

The Text screen will appear.

!

READING AND SAVING TEXT
Please follow the instructions in this chapter in order to
get the best results from your C-Pen. Take a few minutes
to learn how to use C-Pen correctly. See also Optimum
reading conditions p. 7.

Reading text
To read a line, follow the steps below.

1. Turn C-Pen on. Make sure that the text settings are set
to the appropriate values. The text settings are Text
Language, Read Mode and Text Quality. There is also a
possibility to calibrate the C-Pen for best performance.
Refer to Settings, p. 75, to read about the different
settings and how to modify them.

2. Place C-Pen over the first
character you want to
read. Hold C-Pen with the
pen tip flat against the
surface. Aim at the centre of
the line. C-Pen reads one line
at a time.

3. Move C-Pen over the line of text.
Keep the pen tip flat
against the surface while
reading. Make sure the
autotrigger (at the
pen tip) is pressed
backwards into the
pen.

15 cm/s

Text screen

! Please note that the text surface must also be totally flat
in order to achieve maximum reading accuracy.

The read text is placed in a new text file in Notes, see p. 34.
You can also create a new, empty text file by selecting

New... and then FILE in Notes, before you start
reading.

Please note that you can move C-Pen either left-to-right
or right-to-left over the text.
You can read up to 15 cm/second.

Reading another line
Read the second line the same way you read the first. A
space or a line break is inserted between the lines, see
Read Mode, p. 76.

The last line is highlighted (inverted), i.e. white text on a
black background. To cancel the last line, press ESC briefly.
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EDITING TEXT
To be able to edit text in a text file or in an edit field you
have to enter edit mode.

Entering edit mode
You enter edit mode in different ways depending on your
starting-point. You can enter edit mode in the Text screen
or in edit field.

Entering edit mode in the Text screen
Press Nav in the Text screen to open the Text menu.
Select Edit / C Write to enter edit mode. You can now edit
text either by using the Edit menu (see below) or by using
C Write (see p. 26).

Entering edit mode in an edit field
Press Nav when the edit field is highlighted to enter edit
mode. You can now edit text either by using the Edit menu
(see below) or by using C Write (see p. 26).

Edit menu
When you are in edit mode a cursor appears and the edit
mode symbol is shown in the status field.

Edit mode symbol

Deleting a line
To delete any of the lines, do in the following way:

1. Place the cursor (the flashing triangle) in front of the
line and press Nav. The Text menu opens, see p. 36.

2. Scroll through the menu items until you find Select and
press Nav. The line becomes highlighted.

3. Press ESC briefly. The line disappears and you are
ready to read a line again.

Saving text
Press Nav to open the Text menu (see Notes, p. 34) and
choose Exit. The Save As dialog box appears. Choose YES
if you want to save the text, NO if you want to discard the
text or CANCEL if you want to return to the text. The
dialog box also contains an edit field with a suggested file
name. You can change the file name before you save the
file; see Editing text on the following pages.
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Select Highlights characters or a whole text.

Settings Sets the text settings of the text you are
reading. Also the options Calibration and
C Write Feedback are included here.

Cancel Closes the edit menu.

Some of the menu items are explained more in detail
below:

Change
Place the cursor to the left of the character you want to
change and select Change from the menu. Turn Nav to
select the new character from the character set and then
press Nav.

As default the C Write Feedback is enabled and you can
see how the characters should be drawn if you want to
use C-Pen as a normal pen during editing. This visual
feedback is a quick way to remember how the letters are to
be written. See p. 27 for how to turn on/off the C Write
Feedback.

Insert
Move the cursor to the place where you want the
insertion and select Insert from the menu. You can
choose between inserting a space, a line break, a charac-
ter or multiple characters.

In edit mode you move the cursor one character at a time
by turning Nav. Or, you can move to the beginning or the
end of the text with the Go to option in the Edit menu.
Move the cursor to a position where you want to edit the
text. Press Nav to open the Edit menu.

Depending on if you want to edit in C Address or a text in
Notes the options in the Edit menu are slightly different.
The items you can come across in the Edit menu are:

Quit Editing Leaves the edit mode in the Text screen.

Done Leaves the edit mode in an edit field.

Change Changes the character to the right of the
cursor.

Insert Inserts new characters, space or line
breaks at the cursor’s position.

Cut Cuts a selection (available only if
characters have been selected).

Copy Copies a selection (available only if
characters have been selected).

Paste Pastes a cut or copied selection (available
only if a selection has been cut or
copied).

Delete Deletes a character or a selection.

Go to Moves the cursor to the beginning or the
end of the text.

The character set

Edit menu
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Delete
Place the cursor to the left of the character you want to
delete and select Delete from the menu.

If you have selected text, the whole selection will be
deleted, see Select above.

Settings
In Settings you can change text settings, calibration and
the C Write visual feedback. More detailed explanations
of the settings can be found in Settings, p. 75. The
available settings are:

• Text Language: Select the language of the text you are
reading.

• Read Mode: Select Continuous or Separate lines.
• Text Quality: Select Normal or Inverted.

• C Write Feedback: Mark the checkbox if you want the
C Write visual feedback to be on. See p. 27.

• Calibration: you can either calibrate C-Pen or revert to
the default setting. See p. 76.

Quit Editing
Quit edit mode by selecting Quit Editing.

Select Character in the insert menu to insert one charac-
ter. Then turn Nav to select a character from the character
set and press Nav. The character set closes automatically
after the insertion.

To insert more than one character, select Multiple
Characters. Turn Nav to select a character from the
character frame and press Nav. The character set remains
on the display and you can continue inserting characters.
When you are finished, press ESC or alternatively the
DONE button (in the end of the character set) to return to
the text you are editing.

As default the C Write Feedback is on and you can see
how the characters should be drawn if you want to use C-
Pen as a normal pen during editing. This visual feedback
is a quick way to remember how the letters are to be
written. See p. 27 for how to turn on/off the C Write
Feedback.

Select
Use the Select command to edit more than one character
at a time. Then select Characters and turn Nav to mark
multiple characters. Press Nav and choose Cut, Copy or
Delete from the menu.

If you select All, the whole text will be selected.

Cut, Copy and Paste
To be  able to choose Cut, Copy or Paste you must have
selected text. If you have chosen Cut or Copy you can
Paste the text section at the cursor’s position by pressing
Nav and select Paste in the appearing menu.
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Feedback is meant to support you on how to draw the
chosen character if you want to use C-Pen as a normal
pen.

The C Write Feedback utility can be switched on/off in
Settings:

1. Go to Settings.

2. Select C Write Feedback.

3. Uncheck/check the check box according to your
personal preferences.

4. Select OK.

Basic rules when using C Write
• In order to obtain maximum accuracy when writing with

C-Pen, your characters should resemble the prototypes
on the following pages as much as possible.

• A character must be drawn in one single stroke.

• The dot indicates the starting point of the stroke.

• The height of the character should be 1 - 4 cm.

• It is important that the pen tip is in contact with the
surface while you are writing.

• The writing surface must have a distinct pattern, such
as a printed text. Solid colors or simple repetitive
patterns (lines, squares, grids) should be avoided.

Start here

C Write
C Write is a feature that allows you to draw characters by
using C-Pen as an ordinary pen. C-Pen can track its own
movement over a surface and recognize the movement as
a letter, digit or a symbol. C Write is an alternative to
using the character frame when inserting characters in a
text.

To be able to use C Write, the surface you “write” on must
have a distinct pattern. Printed text is the best choice.

Use C Write in the following way:

1. Enter edit mode.

2. Position the cursor on C-Pen’s display.

3. Place C-Pen against a text surface.

4. Form a letter, see C Write Prototypes, p. 29.

5. Lift the pen from the surface.

When the pen is lifted from the surface an image will
briefly turn up, showing the letter shape as perceived by
your C-Pen. You do not have to wait for this image to
disappear to write your next letter.

As default the visual feedback, C Write Feedback, is
enabled and the letters are shown whenever you can
choose a character in the character set. The C Write

Visual feedback
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C Write Prototypes
Letters, digits and shift

Shift Space Backspace New line

Aa Bb Cc Dd Ee

Ff Gg Hh Ii Jj

Kk Ll Mm Nn Oo

Capital letters
When you enter edit mode the
status field will change appear-
ance. The edit mode symbol
indicates that C Write will
generate lowercase letters.

In order to write a capital letter,
you have to write the shift sign
first, see C Write Prototypes.
Only the first letter will be a
capital. The status field will
reflect this choice.

If you write two shift signs, C
Write will enter Caps Lock
mode. All letters will be capitals
until you write a shift sign
again.

Symbols
Press the pen tip briefly against
the surface to enter symbol
mode. The status field displays
the Symbol mode icon.

Write one of the symbols in the symbol table. You are
automatically brought back to normal mode. If you want
to quit symbol mode without writing a symbol, you have
to write a backspace sign.

C Write Capital
letter icon

C Write Caps Lock
mode icon

C Write Symbol
mode icon

The edit mode
symbol shows the C
Write Lowercase
icon
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Special characters

Accents and umlauts

Write the letter first and then the accent or umlaut.
Example: ä = a + 

Symbols

Enter symbol mode by pressing the pen tip briefly against
the surface.

Çç Ææ Øø

¨ º ^ ´ ` ~

. , : ; / \

Pp Qq Rr Ss Tt

Uu Vv XxWw Yy

Zz

1 2 3 4 5

6 7 8 9 0
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APPLICATIONS
C-Pen’s application icons are shown in the Main screen.
You can move between the icons by using Nav. Press Nav
to start an application.

Notes contains text files. See p. 34.

C Address is an address book, where you
can store business cards and search for
contact information. It can be synchronized
with Microsoft Outlook. See p. 38 and 89.

C Calendar works as an ordinary calendar
with the advantage of displaying the
information in many different ways once
you have the information in your C-Pen.

C Dictionary can read and translate words
in-between the languages you have chosen
to buy for your C-Pen. See p. 58.

C Message is used to send SMS, E-mail and
fax messages in combination with a mobile
cellular phone. See p. 67.

( ) [ ] { }

- + * $ @ “

# _ < > ? ¿

! ¡ £ § ß %

Move between the
icons with Nav

Main screen
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Please note that if you are in the Main screen or in
Notes you do not have to do this command to create a
file. New file will automatically be created when you
start to read with C-Pen (except when you already are in
the Text screen). New text files will be placed in Notes.

Select FOLDER to create a new folder. A dialog box
appears. Select the edit field to give the folder a name.

Use your C-Pen to read a name or press Nav to enter edit
mode. To save the folder, select OK. The folder is placed
in Notes.

If you want to save a file within a specific folder, you must
create the file within the folder. Open the folder, select
New... and then select FILE in the dialog box.

The Command menu
The Command menu contains commands for handling
texts. Open the menu by selecting a text file.

!

Settings contains parameters you can
change such as power-off time and reading
options. See p. 75.

Info contains information about your
C-Pen’s serial number, OS version number,
free memory space, etc. See p. 81.

Storage can store files during transport in-
between computers. See p. 82.

C Direct contains information on how to
transfer text from C-Pen directly into a
Windows program by means of infrared
communication. See p. 83 and 90.

C Write contains information about and
examples on how to write letters with C-Pen.
See p. 26 and 83.

Notes
Notes contains the text files you have read and saved.
Enter Notes by selecting the Notes icon in the Main
screen.

Inside Notes, move between items using Nav.

Creating a new file or folder
Selecting New... will open a dialog box. Select FILE to
create a new file.

Your list of text
files starts here

Press Nav to open
the Command menu
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The items in the Text menu are:

Exit Closes the text. If the text has been changed
you are prompted to save it before it is
closed. Select SAVE AS... if you want to save
the changed file with a new name.

Edit/CWrite Enters edit mode. See p. 21.

Settings Opens the text settings of the text you are
reading. See Settings, p. 75.

Select Highlights a read line/word.

Go to Moves the cursor to the beginning or the end
of the text.

Cancel Closes the Text menu.

The options in the Command menu are:

Open Opens the selected file.

Rename Renames the selected file. A dialog box
with an edit field appears.

Delete Removes the selected file.

Properties Displays the file size of the selected
file.The  Creation date and Modified date
will be shown as well.

Send opens a new menu in which you can
choose to send the file as SMS, SMS-Email
or fax message.

Cancel Closes the Command menu.

The Text menu
In the Text screen you move the cursor line by line with
Nav. You can insert a new line at the cursor position (the
flashing triangle) by reading a new line with C-Pen.

Press Nav if you want to edit the text,  go to the beginning
or end of the text, change text settings or stop working
with the text. Pressing Nav opens the Text menu.

Press Nav to open
the Text menu
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In the Contact edit screen, turn Nav to go to the first field,
called First name. Read the first name of your contact
with your C-Pen, for instance from a business card or a
telephone list. Redo the reading if you are not satisfied or
turn Nav to move to the next field, Last Name. Continue
reading text into the following fields in the same way.

You can always move to any field you want by turning
Nav. If you want to redo a reading with C-Pen, just go to
the field that you want to change and read again. Enter
edit mode if you want to edit the content of the field, see
p. 21.

You can change the choice of contact details (addresses,
phone numbers, e-mail addresses etc.) in OPTIONS. Select
OPTIONS and scroll through the options. Check or
uncheck the boxes according to your personal prefer-
ences. When you are finished, select OK or just press
ESC.

You can discard the information you have entered in a
contact file by selecting CANCEL. Select YES, when a
dialog box appears, asking if you want to discard all
changes.

Selecting TOP at the end of the field list brings you to
SAVE. If you choose SAVE, the changes will be saved and
then the Contact edit screen automatically closes.

C Address
C Address is an application in C-Pen for storing and
looking up contact information such as addresses, phone
numbers and e-mail addresses to people and organiza-
tions you communicate with.

C-Pen can store up to 1000 contacts and when the number
of contacts exceeds 50 they will automatically be divided
into folders.

Start C Address by selecting the C Address icon in the
Main Screen.

The C Address main screen will open:

Below the menu items Exit, New... and Find, you will find
your listed contacts.

Enter a new contact
To enter a new contact, select New... in C Address main
screen. The Contact edit screen will open:

Main screen

Contact list

C Address
main screen

Contact edit
screen

Check boxes
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Rename Renames the contact file.

Top Brings you to the top of the C Address main
screen (Exit).

Cancel Closes the Contact menu.

View a contact
Select View to view a contact. The contact information is
presented in the Contact view screen. When opened the
scroll bar rectangle blinks, which indicates that the scroll
bar is active, and you are able to scroll through all contact
information.

To select OK or EDIT, first press Nav to deactivate the
scroll bar – the rectangle stops blinking – then turn Nav to
go to the buttons.

Edit a contact
There are two ways to edit a contact:

1. Select a contact in the contact list. Then select Edit in
the Contact menu.

2. Select EDIT in the Contact view screen.

In both cases the Contact edit screen will open, display-
ing the stored information in the fields. You can move
between the fields by turning Nav. If you want to change

Select SAVE when you are finished. The Save as dialog
box appears. The suggested file name is the name you
entered in the Full name field. If this field is empty or
unchecked the suggested file name will be “Last name,
First Name”. You can edit the file name or you can read a
new file name with your C-Pen.

A file name must not be longer than 64 characters. Invalid
characters like ‘\’ or ‘.’ will be replaced with a blank space.
If the file name already exists, a number suffix will be
added to the file name, for instance ‘John Mill (2)’ if ‘John
Mill’ already exists.

Select YES to save the contact file. A new contact is
added to your contact list.

The contact menu
The Contact menu contains options for working with
contact files. Open the menu by selecting a contact in the
contact list.

The options in the Contact menu are:

View Lets you view the information you have
entered about a contact.

Edit Lets you edit the information you have
entered about a contact.

Delete Deletes the contact file.

Contact
menu

Blinking when activated

Contact
view screen
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If no matching text is found, a dialog box appears telling
you “Nothing found”. Select OK to go back to the Find
Contact screen.

Delete a contact
Select a contact in the contact list and select Delete. A
dialog box asks you to confirm that you are sure. Select
YES. The contact is now deleted.

Exit C Address
You can exit C Address from the C Address main screen
by selecting Exit or by pressing ESC.

the content in a field, you can read a new field text with
C-Pen or edit the text in the usual way.

Find a contact
To find a contact, navigate to the C Address main screen
and select Find. The Find contact screen will open. Enter
the search text either by using C Write, or inserting
characters from the character set.

If the Search all fields check box is checked, all informa-
tion stored in C Address will be searched in order to find
matching text.

If the check box is not checked only names will be
searched, (First name, Last name and Full name).

Select the FIND button to start the search. The Find
contact screen closes and a contact list containing the
contacts with matching information will be displayed. You
can select these files, just as you do in the contact list.

Select DONE to close the screen and return to the
C Address main screen.

Find
contact
screen

Search result
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When you are in the Day view screen another day can be
viewed by clicking the Back/Forward buttons at the
bottom line, see p. 49.

The Day view screen is used to view all the events during
one particular day and the title of the event is listed to the
right of the start time. Depending on the chosen event
alternatives (such as repetition, note and alarm), different
icons can be shown to the right of the event title.

Brackets are used to show the events length and possible
overlapping of other events.

Week view screen
The Week view screen displays a single week at the time
and the screen is reached by selecting the Week view
button, see p. 48, at the bottom line of the display. The
Menu button is then automatically highlighted.

Another week can be viewed by clicking the Back/
Forward buttons at the bottom line, see p. 49.

The Week view screen is used to view all the events

C Calendar

Introduction
C Calendar is an application, which works as an ordinary
calendar but with the advantage that you can display the
information in many different ways once you have the
information in your C-Pen. You can choose to view the
whole month, a single week or a day and you can either
read or write the information into your C-Pen.

Using C Calendar
Start C Calendar by highlighting the C Calendar icon in
the C-Pen Main screen and press Nav.

The present date is displayed on the Day view screen and
you can now choose to continue to view/edit events/
tasks for the current day or change to the Week view
screen, Month  view screen or the Task list, see p. 53.
You can change view screen with the View screen
buttons, see p. 48.

In C Calendar the scroll bar is always present to the right
on the display.

Day view screen
The Day view screen is reached by clicking the Day view
button, see p. 48, at the bottom line of the display and the
Menu button is then automatically highlighted, see p. 49.

Main
screen

Day
view
screen

Week
view
screen

current day
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In the menu you can choose among the alternatives listed
below. Please note that the alternatives New..., Select…
and Go to XX are depending on if you are in the Task list,
day, week or month view screen, see below.

Pressing the Menu button opens the C Calendar main
menu with the following alternatives:

Exit Closes C Calendar and returns to the C-
Pen Main screen.

New… Opens a new event/task in the Event edit
screen/Task edit screen.

Select week Enables the selection of a whole week at a
time in the Month view screen. When a
week is highlighted and Nav is pressed,
the chosen week’s Week view screen will
be displayed.

Select day Enables selection of a day in the current
Week view screen. When a day is high-
lighted and Nav is pressed, the chosen
day is opened in the Day view screen.

Select event Enables selection of one of the listed
events in the current Day view screen.
When an event is highlighted and Nav is
pressed, all the event details are
displayed. See the Details screen p. 54.

during one particular week and the events are shown as
checkered boxes. The size of the box corresponds to the
length of the event and the position corresponds to the
start time.

If the current day is in the chosen week, there is a circle
around the date as can be seen in the figure above.

Month view screen
The Month view screen displays a single month at the
time and the screen is reached by selecting the Month
view button, see p. 48, at the bottom line of the display.
The Menu button is then automatically highlighted.

Another month can be viewed by clicking the Back/
Forward buttons at the bottom line, see p. 49.

The Month view screen is used to view all the events
during one month and the events are shown as small
boxes to the right of the date. The size of the boxes
corresponds to the length of the event and the position
corresponds to the start time.

When viewing the current month the current date is
inverted, as shown in the figure below.

Menu button
Selecting the Menu button opens the C Calendar Main
menu.

Month
view
screen

current day

Main
menu
button

C Calendar Main menu
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button is pressed the Week view screen
appears, see p. 45.

Day button Is on the display represented by the
button with number 1. When the Day
button is pressed the Day view screen
appears, see p. 44.

Task button Is different from the other three buttons.
When the Task button is pressed the
Task list, see p. 53, is opened and
pressing the Menu button will open the C
Calendar main menu. The option Select
task enables you to check or uncheck the
listed tasks, see p. 55.

When a view has been chosen the cursor
automatically highlights the Menu button.

Back/Forward button
To the right at the bottom line of the display there are two
buttons with an arrow on them and they are called Back/
Forward button. The right arrow button is the Forward
button and changes the date forward in time while the left
arrow button, the Back button, changes the date back-
wards.

Select task Enables selection of one task in the
currently displayed Task list. When a
task is highlighted and Nav is pressed, all
the task details are displayed. See the
Details screen p. 54.

Find… Opens the Find dialog. See also Find an
event p. 55.

Go to day/week Where XX is alternatively month, week or
/month... date depending on in which view screen

you are. Go to day/week/month... opens a
dialog in which you can enter a particular
month, week or date. As default the
present month/week/date is selected.

Settings… Show the settings and enable you to edit
them.

Cancel Closes the C Calendar main menu.

View screen buttons
To the left at the bottom line of the display there are three
buttons. The buttons are altered depending on where you
are in C Calendar and they change between the following
four alternatives:

Month button Is on the display represented by the
button with number 31. When the Month
button is pressed the Month view screen
appears, see p. 46.

Week button Is on the display represented by the
button with number 7. When the Week

day

week

month

task
Day, week,
month and task
buttons

Main
menu
button

Back button

Forward button
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Details screen by selecting Edit…. In both cases you can
edit all the fields on the screen.

You can either read an event title directly into the first edit
field, Title, or enter edit mode by pressing Nav and then
use C Write. The same goes for the edit field called Note
in which you can enter the event details.

The next option is reached by turning Nav.

The time and date are changed by highlighting the first
set of figures (in Date that is the year), then pressing Nav
and turn it to the preferred value. When you are done,
press Nav and you will automatically enter the next set of
figures (in Date that is the month) where you can turn Nav
directly to change the value. The checkboxes are
checked/unchecked by pressing Nav.

For further information about the event options and the
Repeat button see Event options below. If a repetitive
event is shown in the Details screen and you select
Edit… after pressing the Menu button, two optional
checkboxes are displayed. You can choose to edit the
event only the current day or for an interval between
dates. If an interval is chosen the default is set to the full
interval, but can be changed if you want to. Clicking OK
will open the event to be edited during the chosen
interval.

If you want to change a date long time ahead the present
date you can press the Menu button and then select the
option Go to day/week/month… in the C Calendar Main
menu, p 46.

Create an event
A new event can be created in two different ways. Either
by pressing the Menu button, see p. 46, while you are in
the day, week or month view screen and then selecting
New…. See Event edit screen, p. 50. Read the text directly
or enter edit mode and write the text into the edit fields
with C Write. Alternatively you can read directly while in
a view screen and the read text will automatically be
placed in the title edit field of the Event edit screen, see p.
50.

Create a task
A new task can be created in two different ways while in
the Task list, see p.53. You can either press the Menu
button while in the day, week or month view screen and
then select New…. Read the text directly or enter edit
mode and write the text into the edit fields with C Write.
Alternatively you can read directly, while in the Task list,
and the read text will automatically be placed in the title
edit field of the Task edit screen, see p. 54.

Event edit screen
The Event edit screen is opened by pressing the Menu
button while in the day, week or month screen view and
then selecting New… . It can also be opened from the

Event edit
screen
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interval of repetition as well as the end date.

The Repeat checkboxes are:

Day Every day.

Week The same day every week.

Month The same date every month.

Year The same date every year.

Please note that the alarm check box is only available if
the start time is chosen in future time.

Task list
When the Task view button is pressed the Task list is
opened and all the tasks in the calendar are displayed in
the order they were entered in C Calendar. The cursor is
set to automatically highlight the Menu button.

The tasks are showed with their title and their state, i.e.
checked or unchecked. The attachment icon is shown
beside a task if there are further notes belonging to that
task. Tasks are checked/unchecked in the Details screen,
see below.

Pressing OK will save the event while Cancel will discard
all changes. After pressing OK/Cancel you automatically
return to the previous screen.

Event options
The Event edit screen, see p. 50,  contains of the follow-
ing options:

Title Event title. You can either read directly into
the edit field or enter C Write and write the
text. Maximum length of the text string is 15
characters.

Time Start and end time in hours and minutes. As
default the start time is set to the present
hour with the duration of one hour.

Date Start date of the event. Year, month and day
can be set. As default the last viewed date in
the Day view screen is set as start date.

Alarm Check/uncheck the start of an audio reminder
of the event. The start time can be set up to
one hour before the event. The alarm is
independent on whether C-Pen is turned on
or off.

Note Further notes concerning the event are
placed in this edit field either by reading text
or by entering C Write and write the text.

Repeat Events can be set to be repeated in a certain
interval, see Repeat checkboxes below, until a
chosen end date. Pressing the Repeat button
opens a dialog in which you can set the

Repeat
dialog

Task
list

unchecked task

attachment icon

tasks

!
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When pressing Nav a menu appears with the alternatives
Done, Check, Edit..., Delete... and Cancel. Pressing
Cancel will bring you to the previous screen.

A task can be checked/unchecked in the Details screen
by pressing Nav and then selecting Check…/Uncheck…
in the menu.

Check/uncheck a task
Tasks are checked/unchecked in the Details screen, see
p. 54, by pressing Nav and then selecting Check…/
Uncheck… in the menu.

Find an event
The Menu button contains the option Find..., which is
used to find a text string among all the stored events. The
text string to be found can be read or written into the edit
field. You can also decide if your search is to be case
sensitive or not.

Task edit screen
The Task edit screen is opened from the Task list in two
different ways. Either you press the Menu button and
then select the option Select task in the menu. Pressing
Nav when the preferred task is highlighted automatically
opens the Task edit screen. Alternatively you can start
reading text while in the Task list. Then the Task edit
screen is opened and the read text is placed in the first
edit field (Title).

Pressing OK will save the task and the updated Task list
is then automatically displayed. Pressing Cancel will
discard all changes made to the event.

Details screen
The Details screen can be opened in two ways. By
pressing the Menu button in the Day view screen and
then choose Select event in the menu you can edit an
event. Highlight an event and press Nav to open the
Details screen. If you want to check the details of a task
you choose Select task after pressing the Menu button
while you are in the Task list. Highlight a task and press
Nav to open the Details screen.

All information about the selected event/task is displayed
on the screen.

Task
edit
screen

task notes

task title cursor

Check.../Uncheck... alternative

Details
screen

back to Task list C Calendar Main menu

attachment icon

Details
screen

alarm icon

day of the event
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Time before Works together with the Default alarm
start setting to enable an audio alarm for

events on a specified time before the start
time.

Use large Enables the usage of large fonts when
fonts ever that is possible in C Calendar.

Delete an event or a task
An event or task is deleted by selecting Delete… in the C
Calendar Main menu while you are viewing the event/
task on the Details screen.

Exit C Calendar
C Calendar is exited by selecting Exit in the C Calendar
Main Menu. Alternatively you can press ESC a few times
in order to get to the C-Pen Main screen.

If there are events containing the text string, they are
displayed on the screen.

Settings…
By pressing the Menu button and choosing Settings…,
the list of settings in C Calendar is opened.

The setting options are:

Show  empty Determines whether to draw full hours or
hours not in the Day view screen, when there

are no events during that time.

Day starts Determines at which time the default day
will start and has also effect on the
different view screens. The default day
will be shown from the start time unless
there are events listed before that time.

Day ends Determines at which time the default day
will end and has the same effect as the
setting Day starts, see above.

Default alarm Is used to enable/disable default alarm for
all new events.

text string

Find...
dialog

Options in
Settings...
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3. Enter your dictionary license key, see Enter dictionary
key below (p. 59).

How to download dictionaries
If you want additional dictionaries:

1. Place your C-Pen in front of your computer’s IR port
and double-click My C-Pen on your PC. The C-Pen
Viewer is opened.

2. Double-click C Dictionary in My C-Pen.

3. Click the My C-Pen icon to the left in the C-Pen Viewer
and then locate and click the folder /Dicts. All dictio
naries available are stored in this folder. The folder is
placed on the C-Pen Windows Software CD.

4. Select and copy the dictionary file (files with the
extension dictionary.dic) you want to download to
your C-Pen. Click C Dictionary and then paste the
files.  Another option is to select the files and then
drag and drop them on the C Dictionary icon.

5. Disconnect your C-Pen by selecting Disconnect C-Pen
in the C-Pen Viewer’s File menu.
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Enter dictionary key
1. Pick up your C-Pen, start C Dictionary by selecting the

C Dictionary icon in the Main menu. A dialog appears
in which you can select the dictionary according to
your preferences and then press OK. Enter your
dictionary license key in the “enter key dialog box”.

C Dictionary

Introduction
C Dictionary is a software package, which enables your
C-Pen to translate a word from one language to another
within less than one second. It is possible to translate one
word at a time, but you can also read several words at the
same time and then select and translate word by word.
Additionally you can write words yourself with C Write
and quickly get them translated.

Every package contains one bilingual Oxford or Norstedts
dictionary. The available languages are listed both on the
C-Pen Windows Software CD and at our web site:
http://www.cdictionary.com

Installation of dictionaries
If you want to buy a dictionary, you can do so at our web
site http://www.cdictionary.com

There you will also find C-Pen updates, latest news and
current prices.

1. Buy a license for the dictionary you want in order to
acquire the dictionary license key. To buy a dictionary
license you use your credit card for on-line purchasing.
You must also attach your C-Pen’s serial number. The
dictionary license key is valid for this C-Pen’s serial
number only. If the credit card number is valid, you
receive your dictionary license key.

2. Download the dictionary, see How to download dictio-
naries, p. 59.
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If you want to install the dictionary again:

1. Download the dictionary, see How to download dictio-
naries, p. 59.

2. Enter your dictionary license key, see Enter dictionary
key, p. 59.

Additional Information
Additional information, such as explanations to the
dictionaries and a list of abbreviations used, is available
on the C-Pen Windows Software CD. The information is
located in a set of files in the same folder as the dictionar-
ies, /Dicts.

Using C Dictionary
Start C Dictionary by selecting the C Dictionary icon in
the Main screen and press Nav.

C-Pen is now ready to translate words. If you want to
change dictionaries before you start reading, see Dictio-
naries button p. 66.

Turn Nav to enter the first digit in the dictionary key.
Then press Nav to go to the next position and continue
in the same way until OK is selected. Press Nav and
you are able to use the dictionary. If you press ESC
you will exit C Dictionary.

2. The dictionary you selected is now ready to be used.
The same license key is valid for both parts of the
dictionary, but you just have to type it in once. Press
INFO in the C Dictionary main screen to view your
dictionary license key.

To uninstall dictionaries
Please make sure you have your dictionary licence key
written down. If you loose your key you also loose your
dictionary !

1. Place your C-Pen in front of your computer’s IR port
and double-click My C-Pen.

2. Double-click C Dictionary.

3. Select the dictionaryname.dic file representing the
dictionary you want to remove.

4. Open the File menu.

5. Select Delete.

6. Answer yes to the question if you want to delete the
dictionary.

Enter
dictionary
key

Main screen

Word edit box

The language from which you translate

Dictionaries button Info button

C Dictionary
main screen
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Close the Translation screen by pressing Nav or ESC.

Pressing the pen tip briefly against the surface will delete
the current reading and bring you back to the C Dictio-
nary main screen.

A new word can be read without closing the screen.

Word selection list
If the current read word does not match any word in the
dictionary, the application will search for similar words
and present these alternatives in a Word selection list.

The reason to why a word is not found can be that the
word is misspelt or that the OCR has given an erroneous
result. Another reason can be that the word is inflected
(e.g. chairs instead of chair).

The most probable word is presented at the top of the list
and the others in probability order. A maximum of ten
words are displayed. Select the matching word to see the
translation.

To translate a word, just read the word with C-Pen as
usual. One of the following situations occur:

1. The word is found in the dictionary and the translation
is presented on the screen, see Translation screen p.
62.

2. No exact match of the word is found in the dictionary
and a list of alternatives is displayed, see Word
selection list, p. 63.

3. Several words are read. The words are shown on a new
screen where you can select the words to be trans-
lated, see Word selection screen, p. 64.

4. A dialog box appears, telling that the word cannot be
found in the dictionary.

When you are reading a word there is a possibility that
the word (or part of the word) in front of and/or behind
the accurate word also is included. If this is the case
C Dictionary acts according to the following rules:

• If two words are read, the longest word is translated.

• If three words are read, the middle word is translated.

• If more than three words are read, the Word selection
screen is displayed, see p. 64.

Translation screen
The Translation screen displays the translation of the
selected word. A scroll bar appears if only part of the text
is shown. Turn Nav to scroll the text.

The meaning of bold and italic characters is explained in
Info, see Info button p. 66.

Translation
Screen

Word
selection
list
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Word edit box
The read word/words are directed to an edit box where
you can edit them in the usual way.

1. To be able to edit you must first close the dialogs, lists
or screens that might have turned up after reading.

2. The edit box is already selected. Press Nav and a cursor
will indicate that you are in edit mode.

3. Press Nav again to open the Edit menu or use C Write
to edit the word.

4. When you have finished editing, select Done in the
Edit menu.

5. The edited word will now be looked up in the dictio-
nary.

Word references
Some words in the dictionaries contain references to other
words. The references are displayed in bold and italic
style. If you press Nav when a word reference is dis-
played, a menu appears and you can choose to:

• look up the reference

• cancel the menu

• close the translation containing the reference

If you choose to look up the  reference, the word will be
translated.

Text Language
The Text Language is automatically set to the language
you are translating from; i.e. German is set for the German-

A Word selection list can also be displayed if more than
one word is found with the same spelling as the current
read word, but with different meanings.

Close the Word selection list by selecting Cancel or by
pressing the ESC button.

Pressing the pen tip briefly against the surface will delete
the current reading and bring you back to the C Dictio-
nary main screen.

You can start to read a new word without closing the list.

Word selection screen
If more than three words are read the Word selection
screen appears. Turn Nav to select a word.

The selected word is looked up and either the Translation
screen, Word selection list or Can’t find dialog box is
displayed.

Close the Word selection screen by pressing ESC or by
selecting the CANCEL button.

Pressing the pen tip briefly against the surface will delete
the current reading and bring you back to the C Dictio-
nary main screen.

You can start to read a new word without closing the
screen.

Word selection
screen
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C Message

Introduction
C Message is an application for sending text messages
and it is used in combination with a mobile cellular phone.
C Message consists of C Fax and C SMS. The applica-
tion C SMS is used when you want to send text mes-
sages, SMS, to someone’s mobile phone or an e-mail to
their e-mail account.

You can either send complete files from Notes or write a
short message with C Write directly into C Message and
then send it. The SMS standard limits the messages sent
with C SMS to a length of 160 characters. Fax messages
are not limited.

Please note that C Fax and C SMS require a mobile
cellular phone equipped with an IR eye and a fax modem.

Using C Message
There are two ways to send a message, either from C
Message or directly from Notes.

If you want to send a new text not stored in Notes you
can select the C Message icon in the C-Pen Main screen.

The C Message main screen is opened and you can now
send a fax or SMS by selecting C Fax or C SMS.

!

English dictionary. Exiting C Dictionary will restore the
Text Language to the language that was set before
entering C Dictionary.

Dictionaries button
The DICTIONARIES button in C Dictionary’s main screen:

gives you access to the list of dictionaries on your C-
Pen. Choose the dictionary you want to use by checking
its box, and then select OK.

If you want to use the same dictionary the next time you
use your C-Pen you do not have to repeat this procedure,
since the dictionary setting is stored when C-Pen is
turned off.

Info button
The INFO button displays information about the currently
selected dictionary; number of words and manufacturer of
the database. Your dictionary license key is also shown.

Exit C Dictionary
You can exit C Dictionary from the C Dictionary main
screen by selecting EXIT. Alternatively you can press
ESC a few times and you will get back to the Main
screen.

C Dictionary
main screen

Dictionaries button

C-Pen
Main
screen
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Before sending the message check that the C-Pen IR eye
is in range of the cellular phone’s IR eye and that the
phone’s IR communication is turned on. Also make sure
that the fax modem is turned on.

C Fax main screen
When C Fax is selected in the C Message main screen
the C Fax main screen is opened.

The options in the C Fax main screen are:

Exit Exits C Fax and returns to C Message
main screen.

New fax… Opens the Contact list, see p. 70.

Settings Setting options for C Fax.

Sent Successfully sent fax messages are stored
in this folder.

Unsent Unsent fax messages, due to trans-
mission error or the user selecting
CANCEL, are stored in this folder.

C SMS main screen
When C SMS is selected in the C Message main screen
the C SMS main screen is opened.

In order to send a text file stored in Notes you have to
open Notes, select the file and in the appearing menu
select Send. A new menu contains the C Message options
and you can choose the alternative according to your
preferences.

If C Fax is chosen the C Fax main screen is opened, see
p. 69. Selecting New fax… will open the Contact list, see
p. 70,  from which you can select the contact you want to
send the message to. Please note that only the contacts
listed with a fax number will be shown in the Contact list.
If the recipient is not listed you can select NEW... and fill
in the contact information in the Message setup screen,
see p. 71.

If C SMS is selected the C SMS main screen is opened,
see p. 69. Selecting New SMS… or New SMS-Email… will
open the Contact list, see p. 70, from which you can
select the contact you want to send the message to.
Please note that only the contacts listed with a cellphone
number (for SMS message) or e-mail address (for e-mail)
will be shown in the Contact list. If the recipient is not
stored you can select NEW… and type in the contact
information in the Message setup screen, see p. 71.

Successfully sent messages are stored in the folder
named Sent. Messages not sent, due to transmission
error or the user selecting CANCEL, are stored in the
folder named Unsent.

C Message
main
screen

C Fax
main
screen
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If you want to add the new contact information to your
address book you can click the ADD TO C ADDRESS

button at the bottom line in the Message setup screen.

Message setup screen
The Message setup screen is opened when you select
either OK or NEW… in the Contact list, see p. 70. There
are different options depending on if a fax, SMS or SMS-
Email is to be sent.

The buttons in the Message setup screen are:

ADD TO C Adds the new information now inserted
ADDRESS to the setup screen, as a new contact in

your address book in C Address.

SEND Starts to send the message if the
connection to the mobile phone is ok.
The sent message is stored in the Sent
folder. If the connections did not work,
the message is stored in the Unsent
folder.

CANCEL Cancels the Message setup screen and
returns to the previous screen. The
message is stored in the Unsent folder.

The options in the C SMS main screen are:

Exit Exits C Fax and returns to C Message
main screen.

New SMS… Opens the Contact list, see p. 70.

New SMS- Opens the Contact list, see p. 70.
Email…

Sent Successfully sent SMS messages are
stored in this folder.

Unsent Unsent SMS messages, due to trans-
mission error or the user selecting
CANCEL, are stored in this folder.

Contact list
The Contact list is opened when you select New fax…,
New SMS… or New SMS-Email…. If there are no
contacts listed with an e-mail/fax/sms number the Contact
list will not be displayed. Instead you go directly to the
Message setup screen, see p. 71.

The contacts listed in your address book, C Address, are
showed and you can select a contact by checking its
check box. If you want to send a message to a person not
listed in your address book you can select the NEW…
and read/write the information directly into the Message
setup screen, see p. 71.

C SMS
main
screen

Stored contacts
in C Address

Contact
list

The message recipient
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All fields can be edited either by reading text or by writing
text with C Write.

If OK was selected in the Contact list the chosen
contact’s name and number are automatically entered in
the setup screen.

If Send was selected from Notes you will find the selected
file in the Message text field in the Message setup screen.

Settings
There is a Settings menu for the fax page setup and it is
reached from the C Fax main screen.

The Settings menu contains the following options:

Sender info Information about the sender, such as
name and company. The information will
be inserted on all fax pages once it has
been entered. The information is stored in
the C-Pen memory and has to be entered
only once.

Logotype A list of the stored logotypes, from which
you can select the one you want to have
on your fax page. See p. 74.

Footer A list of the stored footer images, in
which you can select the one you want to
have on your fax page. See p. 74.

The fax options are:

To The name of the recipient.

Fax number The recipient’s fax number.

Subject Message subject.

CC Name/Email address of other person/
persons to get a copy of the message.

From The name of the sender/user.

Message The message to be sent.

The C SMS/SMS-Email options are:

Cellphone The recipient’s cellphone number, needed
number for SMS messages.

Email The recipient’s e-mail address, needed for
SMS-Email.

Email gateway Email gateway, needed for SMS-Email. Is
given to you by your cellular phone
operator.

Message The message to be sent.

Message setup
screen for fax

Message setup
screen for SMS-
Email

Message text field

This number is given by your
cellular phone retailor.

The C Fax
Settings menu
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Settings 
Settings contains the parameters controlling C-Pen. Enter
Settings from the Main screen by selecting the Settings
icon. You can also enter text settings from the Text menu
(p. 36) and the Edit menu (p. 21). A list of the available
settings appears.

To modify a setting:

1. Turn Nav to highlight the setting you want to change.
Press Nav and a check box or menu appears.

2. Turn Nav to highlight the option you want and press
Nav to check the chosen value.

3. Select OK to close the dialog and save the changed
setting.

4. You exit Settings by selecting Exit at the top of the
Settings menu or alternatively, press ESC.

The following settings are available:

• Text Language

• Read Mode

• Text Quality

• C Write Feedback

• Calibration

• System Settings

Text Language, Read Mode and Text Quality are referred
to as text settings. You must use these text settings in
order to achieve the optimal OCR.

!

Resolution The resolution of the fax page with the
options Normal (low resolution) and Fine
(high resolution). Please note that trans-
mission of fine resolution fax pages is
more time consuming.

Cancel Cancels the Settings menu and returns to
the C Fax main screen.

Download logotype and footer
If you have logotypes and/or footers you want to add to
your C-Pen fax pages you can download them from your
PC to your C-Pen.

Establish a connection between your C-Pen and your PC.
Open the C-Pen viewer and copy the image files from
your PC and paste them in the C Fax Logos folder in
Storage, see p. 82. Alternatively you can drag the file from
the PC folder and drop them on the C Fax Logos folder in
Storage.

Please note that the image files must be uncompressed
and of black and white BMP format.

Exit C Message
You can exit C Message from the C Message main screen
by selecting the Exit icon. Alternatively, press ESC a few
times in order to get back to the C-Pen Main screen.

The C Fax Logos
folder in Storage
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particular surface. If your C-Pen reads badly you can try
to calibrate. However, the default setting is meant to
manage most cases.

Calibration contains two options:

1. Calibrate, with the possibilities to:

• Calibrate immediately by moving the pen over the text
surface, see How to calibrate p. 80.

• Set the DEFAULT SETTING which is our factory setting.

2. Options, in which you can enable/disable the Quick
Calibration option.

Quick calibration enables C-Pen to start a calibration
as soon as you press the pen tip flat against the
surface and hold it still for about two seconds. Quick
calibration is a preferred option if you often read texts
with very different text contrasts. Quick calibration is
disabled as default.

Text Language
Select the language of the text you want to read from the
list of check boxes. If you read text containing numbers
only, select Numbers Only as language.

Read Mode
Read Mode adjusts C-Pen reading format, and they are:

Continuous: A space is inserted between two
separate readings with the C-Pen.
Suitable when you read a complete
paragraph which will be used in a
document on your PC.

Separate lines: Each reading starts on a new line.

Text Quality
Use this setting to indicate if the printed text is normal or
inverted

Normal: Black text on white background.

Inverted: White text on black background.

C Write Feedback
Check the box if you want to enable the visual feedback
facility in C Write.

Calibration
The Calibration option increases C-Pen’s reading ability
if the text is not black and/or the background surface is
not white. During the calibration process, C-Pen will find
the appropriate balance of black and white for the
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System Settings
PIN code You can control the access of your

C-Pen by a four-digit PIN code. Enter the
PIN code setting to enable or disable
your PIN (Personal Identification
Number).
When the dialog box opens, the zero in
the first position blinks. Turn Nav to
select the first digit in your PIN. Then

How to Calibrate
Calibrate adjusts C-Pen’s reading ability according to the
contrast between the text and its background. When C-
Pen instructs you to calibrate, follow these instructions:

1. Hold C-Pen with the pen tip flat against the surface.

2. A progress indicator appears on C-Pen’s screen.

3. Move C-Pen over the text, in circles or back and forth.
Continue to move C-Pen until the progress bar has
reached the end.

4. A message indicates that the calibration is ready:

If the calibration is done from another menu than the
Settings main menu, you should first hold the pen still
for two seconds and then move it over the surface.

When your C-Pen is calibrated the Text
Quality icon in the status field changes
appearance:

The calibration overrides the factory
setting. The calibration is not saved when C-Pen is turned
off. If you want to revert to the factory setting without
turning C-Pen off, select Calibration in Settings and then
Calibrate. Select DEFAULT SETTING in the dialog box.

Inverted text must still be set in Text Quality. Please
remember that it is impossible to read red text. If the
calibration does not improve the reading accuracy, return
to the default setting.

press Nav to go the next position.
Continue in the same way. When you
have reached OK,  press Nav and
confirm the PIN in a new dialog box.

If a PIN-code is enabled, you must enter
the PIN each time C-Pen is turned on.
After three unsuccessful attempts,
C-Pen will turn off. You get three
attempts each time you start C-Pen.

Warning! If you start C-Pen by selecting
DISABLE PIN CODE in the start up dialog
box, all data in C-Pen will be lost! You
can change or disable your PIN code by
selecting PIN code in System Settings.

Text Quality
icon
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Info
Info contains a list of help and information topics.

Exit Exits Info.

Getting started Gives instructions on performing a
successful reading. Press Nav or
ESC to close the topic.

Troubleshooting Gives solutions to common
problems. Press Nav or ESC to
close the topic.

Support Contains support addresses to
C Technologies.  Press Nav or ESC
to close the topic.

About C-Pen Contains OS version number, HDB
version number and serial number.
You should know these numbers if
you contact C Technologies for
support. Also the amount of free
memory space is listed. If the scroll
bar is present, select it and turn Nav
to scroll through the information.
To close the topic, deactivate the
scroll bar by pressing Nav or ESC,
then select OK or press ESC.

Contrast Display contrast. Select the bar and turn
Nav to change the display contrast.

Time The time showed in the status field can
be set according to your preferences.

Sound The Alarm sound and the System sound
can be switched on/off. The System
sound is activated in combination with
certain message dialogs.

Menu Language The language that C-Pen uses in its
menus and dialog boxes. Select the
desired menu language in the list of
check boxes.

Font The font size on C-Pen’s display can be
altered between Large (default) and
Small. Large gives 5 row display, Small
gives 7 row display.

Power off time The time of inactivity in minutes before
C-Pen turns off automatically.

Left/Right Hand A Left/Right-handed option. Check Left
or Right to orientate the text on the
display for left- or right-handed use.
Select OK and press Nav.

Autotrigger As default the autotrigger is enabled.
The Autotrigger can be switched off and
then you have to press the former ESC
button in order to read text. The ESC
button has become the Trigger and then
there is no ESC button.
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C Direct
C Direct gives you the opportunity to enter text from
your C-Pen directly at the cursor position in Windows
programs, such as Excel or Word.

When you read text with C-Pen, it will appear as usual on
C-Pen’s display. To transfer the text to the PC program,
direct C-Pen’s IR-eye towards the PC’s IR port. The text
will disappear from C-Pen’s display and be transferred to
the cursor position in the PC program.

For further information on how to use C Direct, see p. 90.

C Write
C Write is a feature that allows you to draw characters by
using C-Pen as an ordinary pen. C Write makes it
possible to quickly write new texts into your C-Pen but it
is also an important tool during editing.

C-Pen can track its own movement over a surface and
recognize the movement as a letter, digit or a symbol. C
Write is an alternative to use the character frame when
inserting characters in a text.

For further information on how to use C Write, see p. 26.

files you wish to delete and then pressing the Delete
button on your keyboard. The Delete command is also
available in the File menu but please note that this
operation can not be undone.

Storage 
Storage is a storage area that can be used as a floppy disk
when C-Pen is connected to a PC.  Storage also contains
the folder C Fax Logos, see p. 73 and 74, which is used
when sending fax messages, see C Message.
Selecting a file in Storage opens a menu with the
following menu items:

• Open opens the selected file.

• Delete removes the selected file.

• Properties displays the selected file’s size, creation
date and date of last modification.

• Cancel cancels the menu.

In order to start Storage you have to connect to C-Pen by
double-clicking the My C-Pen icon on your PC. Then,
Storage is started by double-clicking the Storage icon in
C-Pen Viewer on your PC. Files which can be edited in C-
Pen Edit (e.g. filename.txt) are opened by double-clicking
the files. Other file types can be opened in two ways:

• copy the file to a temporary folder on your PC and then
open it with its default Windows application.

• double-click the file and you will be asked if you want
to open a copy instead. Choose to open a copy.

In these cases, if you edit the file and save it, your
changes will be saved on your PC and not in your C-Pen.
Copying files is done according to Windows standard, i.e.
either by using drag-and-drop or Copy/Paste in the Edit
menu. You can delete files in Storage by selecting the file/



8584

Infrared hardware on laptops can be configured in many
different ways. Please read the Installation Help on the
C-Pen Windows Software CD before installing infrared
software. If you have questions which the Installation
Help and ReadMe file on the CD does not solve, please
refer to the C-Pen Windows Software Help, your laptop
retailer or manufacturer.

To install the C-Pen Windows Software:

1. Put the C-Pen Windows Software CD into your
computer’s CD-ROM drive and the installation program
will start automatically. If the installation does not start,
open the Start menu in the Windows taskbar, select
Run and type d:\cpen.exe, where d: is the drive letter
for your CD-ROM drive.

2. Select your C-Pen model.

3. To install the C-Pen Windows Software, click Software
installation and then C-Pen. Please read the Installa-
tion Help if you are uncertain which options you
should select during the installation.

If no infrared drivers are installed on your computer, click
Software installation and then  IR to start the IR installa-
tion program. Please read the Installation Help in order
to install the IR driver properly. It is crucial to select the
proper options in order to get the IR to work.

The installation program also enables you to view the C-
Pen Introduction, which demonstrates how you should
use C-Pen for best results. To play the demo, click C-Pen
introduction.

CONNECTING TO A PC
C-Pen can be connected to a PC by Infrared (IR) commu-
nication. A working IR connection with a PC is required to
install and remove applications in C-Pen. To enable this
communication certain hardware and software must be
installed and configured properly on your PC. The
following is required:

1. IR port. Laptop computers often have a built-in IR port.
Refer to your computer’s manual to find out whether
your computer is equipped with an IR port and if so,
where it is located. Most desktop computers do not
have a built-in IR port. In this case you must use an
external IR adapter. Refer to your retailer if you do not
have an IR adapter.

2. Infrared drivers for Windows 95/98 are included on the
C-Pen Windows Software CD. Please read the Installa-
tion Help on the C-Pen Windows Software CD. It is
crucial to install the infrared driver properly.

3. The C-Pen Windows Software. This software is
installed using the C-Pen Windows Software CD.

Installing software
The Infrared drivers and the C-Pen Windows Software are
installed when you run the installation programs on the
CD. Infrared drivers are possibly already installed on your
computer. The option Documentation contains the User
Guide, Help, Read Me and Installation Help. Click the
file you want to read.
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C-Pen Viewer
Open the C-Pen Viewer by double-clicking the My C-Pen
icon. The C-Pen Viewer enables you to browse the
contents of your C-Pen.

The user interface looks like Windows Explorer and you
will recognize the applications from the Main screen in C-
Pen. Use C-Pen Viewer to open and browse files in your
C-Pen, to create new folders and to remove applications
from your C-Pen.

Your C-Pen Viewer might look different compared to the
figure above, depending on which options you have
enabled in the Explorer’s View menu.

Connecting C-Pen to a PC
To connect C-Pen to your PC, position C-Pen so that it is
aligned with the PC’s IR port as shown in the figure.

The installation program has placed C-Pen icon (My C-
Pen) on your computer’s desktop. When C-Pen is within
range of the computer’s IR port you can double-click the
icon. If the computer’s IR port connects to C-Pen, an IR
icon will appear in the status field on C-Pen’s
display. On most laptops the built-in IR port - a
red or black glossy square - is found on the back
or side of the computer.

Getting help
To get more detailed help using the C-Pen Windows
Software, first open the C-Pen Viewer (by double-clicking
My C-Pen icon) and from the Help menu select the C-Pen
Help Topics. You can also press F1 on your keyboard to
enter the C-Pen Windows Software Help.
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Notes, for example, may only contain text files. Also see
Storage p. 82.

C Address
C Address, the C-Pen address book, is available in the C-
Pen Viewer on your PC. Double-clicking on C Address in
the C-Pen Viewer presents the address files stored in C-
Pen, listed by their contact name.

The address files are stored as vCard files (filename.vcf)
and can be opened by a vCard viewer such as Netscape
Communicator or Microsoft Outlook/Microsoft Outlook
Express on your PC. Double-click on the file and then
click Yes in the dialog. Please note that this will open a
copy of the file and that your changes will be saved on
your hard drive, not in C-Pen.

To put an edited address file back into C-Pen, simply drag
it from a folder on your PC and drop it into the C Address
application in the C-Pen Viewer. Note that the dropped file
cannot have the same name as an existing file in C
Address. If it does, you are prompted to change its name
or replace the existing file in C-Pen.

It is possible to synchronize your address files in
C Address with those in Microsoft Outlook (but not
Microsoft Outlook Express). Simply click your right
mouse button on the My C-Pen icon on the PC desktop
and the option C Sync will appear. Selecting it will start an
easy-to-use application allowing you to specify the extent
of synchronization. Please note that this application only
works if you have Microsoft Outlook installed on your
computer.

Installing and removing applications
The applications in your C-Pen can be removed and new
ones installed. The C-Pen application’s file name is “.car”
(C-Pen Archive). The files do not have to be placed in any
specific folder on your PC, C-Pen will find them regard-
less.

To install a new application in C-Pen simply double-click
on the “.car” file you want and the installation will begin.
You have to turn C-Pen off and on again to complete the
process.

To remove an application from C-Pen select the applica-
tion in the C-Pen Viewer and choose Uninstall C-Pen
Application from the File menu and follow the instruc-
tions on the screen. You have to turn C-Pen off and
on again to complete the process.

Some applications are part of the basic C-Pen functional-
ity and cannot be uninstalled. You can see if it is possible
to uninstall an application by selecting it and then open
the File menu. The application can be uninstalled if the
menu option Uninstall C-Pen Application is enabled.

Transferring files
Transfer files between C-Pen and the PC the same way as
when working with a floppy disk or a hard drive. In C-Pen
Viewer, find the file you want to transfer (e.g. a text file in
Notes) and drag the file to a folder on your PC.

When transferring files from the PC to C-Pen, remember
that each application accepts only its own kind of files.
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C-Pen Edit
C-Pen Edit is a simple text editor that lets you edit files
stored in C-Pen directly on your PC, without having to
first move them to your PC.

C-Pen Edit can communicate directly with your C-Pen to
open and save files. If you are using C-Pen Edit and open
a file from C-Pen, it can be saved either to your hard drive
or directly back into C-Pen. The same applies when you
open a file from your hard drive.

C-Pen Edit provides basic text editing, such as cut, copy,
paste, find and replace. If you double-click on a text file in
Notes in the C-Pen Viewer, it is automatically opened in
C-Pen Edit.

Closing the connection
Close the connection between your C-Pen and your PC
by selecting Disconnect C-Pen from the File menu in the
C-Pen Viewer.

C Direct
C Direct gives you the opportunity to enter text from
your C-Pen at the cursor position in Windows programs,
such as Excel or Word.

To activate C Direct place C-Pen in front of the IR port on
your PC, click the My C-Pen icon with the right mouse
button and select C Direct from the context menu. The C
Direct icon will appear in the system tray in the lower
right corner of your screen. The icon is partly yellow
when C Direct is on (connected) otherwise
the icon is totally grey. The system tray
holds icons of frequently used functions in
Windows e.g. volume control and time.

The display on your C-Pen will show “C Direct”.

When you now read text with C-Pen, it will appear as
usual on C-Pen’s display. To transfer the text to the PC
program, direct C-Pen’s IR-eye towards the PC’s IR port.
The text will disappear from C-Pen’s display and be
transferred to the cursor position in the PC program.

The easiest way to control C Direct is from the C Direct
icon in the system tray in Windows. By clicking the icon,
you can choose Connect, Disconnect or Exit C Direct. To
activate C Direct you can simply double-click the icon.
For more information on how to use C Direct, please refer
to the C-Pen Windows Software Help.

System tray
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INDEX
A
Alarm  80
Application  33
Application icon  12

B
Battery compartment  10

C
C Address  6, 33, 38, 89

C Address main screen  39
Contact edit screen  39
Contact list  39
Contact menu  40
Delete a contact  43
Edit a contact  41
Enter a new contact  38
Find a contact  42
Find contact screen

43, 49, 53, 63, 65, 69, 71, 73
Options  39
Saving a file  40
Synchronizing address files

89
vCard files  89
View a contact  41

C Calendar  44
Alarm  52, 56
Back/Forward button

45, 46, 49
Check/Uncheck task  55
Create event  50
Create task  50
Day view button  44, 49

Day view screen  44
Delet event/task  57
Details screen  51, 54
Event edit screen  50, 52
Event options  52
Event/Task info  54
Exit  57
Find an event  48, 55
Get started  44
Main menu  46
Menu button  46
Month view button  46, 48
Month view screen  46
Repeat button  51
Repeat options  52, 53
Settings  56
Task button  49
Task edit screen  54
Task list  53
View screen buttons  44, 48
Week button  48
Week view button  45
Week view screen  45

C Dictionary  6, 44, 58
Dictionary license  59
Download dictionary  59
Introduction  44, 58, 67
Text language  65
Translation screen  62
Uninstall  60
Use C Dictionary

44, 46, 48, 61
Word edit box  65
Word references  65
Word selection list  63

TECHNICAL SPECIFICATIONS
Size: 140x35x20 mm

Weight: 85 g

Display: 5-7 rows

Processor: Intel© StrongARM™ 100 MHz

Memory: 512 kB RAM
8 MB flash memory

Battery lifetime: 2–3 weeks normal use

Reading speed: 15 cm/s

Character sizes: 7–20 points
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Download footer  74
Download logotype  74

E
Edit field  13, 16
Edit menu  21, 22

Change  23
Delete  25
Go to  22
Insert  23
Select  24
Settings  25

Edit mode  21
Edit mode symbol  17, 21
Editing text  21

C Write  26
Edit field  21
Edit menu  21
Edit mode symbol  21
Entering edit mode  21
Text screen  21

Email gateway  72
Escape button (ESC)  10, 11
Event  50

edit screen  52
options  52

Event/task info  54

F
Fax options  72
File

Creating a new file  34
Delete  36
Open  36

Properties  36
Rename  36

Find an event  55
Footer  73

I
Info  34, 81

C-Pen facts  81

Infrared (IR) communication
84

Infrared driver  84
Installing

Applications  88
Batteries  14
Software  84

Inverted text  76
IR icon  86
IR port  10, 11, 84, 86

L
Language, setting  76
Line break  76
Logotype  73

M
Main screen  12, 33
Menu  12

Menu items  13

Menu language  80
Message setup screen  68, 71
Month view button  46
Month view screen  46

Word selection screen  64

C Direct  5, 34, 90
C Fax Logos  74
C Fax main screen  69, 73
C Fax options  69
C Message  67

Add to C Address button  71
C Fax Logos  74
C Fax main screen

68, 69, 73
C Fax options  69, 72
C SMS  68
C SMS main screen  68, 69
C SMS options  72
Contact list  68, 70, 71
Criteria  67
Email gateway  72
Email options  72
Exit  74
Footer  73, 74
Get started  67
Logotype  73, 74
Message setup screen

68, 70, 71
Send a message  67
Send file stored in Notes  68
Sent  68, 69, 70
Settings  73
Unsent  68, 69, 70
usage  67

C Read  5, 18
C SMS main screen  69
C SMS options  72
C Write  6, 26, 34

Basic rules  27

C Write Feedback  27
C Write Prototypes  29
Capital letters  28
Symbols  28

C-Pen Edit  91
C-Pen Viewer  87
Calibrate

How to...  78

Calibration  76, 78
Quick  77

Camera opening  10
Character confusion  7
Character set  23
Character size  8
Check box  13, 17
Command menu  35
Connecting to a PC  84
Contact list  39, 70
Contact menu  40
Contrast  80
Create task  50
Creating a folder  34
Cursor  17, 21, 36

D
Day view button  44
Day view screen  44
Dialog box  13
Dialog button  13, 16
Display  10
Display object  11
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Text Language icon
13, 15, 67

Text menu  36
Text Quality  76. See

Calibration: Default
setting

Text Quality icon
13, 15, 78

Text screen  19, 21
Text settings  75
Time  80
Transferring files  88
Trigger button (Trigg)  10
Troubleshooting  81
Turning On/Off  14

V
View screen buttons  44, 48

W
Warranty  98
Week view button  45
Week view screen  45

N
Navigation control (Nav)

10, 15
Notes  33, 34

Command menu  35
Create new file or folder

34
Edit / C Write  37
List of text files  35
Text menu  36

O
OCR  7
On/Off button  10, 14

P
Pin code  79

R
Read Mode  76
Reading conditions  7
Reading text  18

Deleting a line  19
Text screen  19

Removing applications  88

S
Saving text  20
Scroll bar  13
Selecting  15
Send file in Notes  68
Settings  33, 34, 75, 82

Alarm  80
Autotrigger  80

C Write Feedback  27, 76
Calibration  76
Contrast  80
Font  80
Left/right hand  80
Menu Language  80
Modify a setting  75
Pin code  79
Power off time  80
Read Mode  76
Sound  80
System settings  79
Text Language  76
Text Quality  76
Time  80

SMS-Email options  72
Status field  12
Storage

C Fax Logos  74
Delete files  82
File properties  82

Support  9, 81
Synchronizing address files  89
System Settings

Contrast  80
Pin code  79

T
Task edit screen  54
Task list  53, 54
Technical specifications  92
Text colors  8
Text, inverted  76
Text Language  76
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Warranty Information

Serial number:

Customer:

Date:

Address:

Dealer:

Address:

CT number:

WARRANTY
C Technologies AB warrants that this product is free from defects in materials and function at the time
of original purchase and for a period of one year from that date. When the name C Technologies is
mentioned in the following text, it means, unless otherwise stated, C Technologies AB (reg. number
556532-3929), its subsidiaries and retailers.

If, during the warranty period, any defect in the product arises due to a deficiency in materials or
function, C Technologies pledges to, at C Technologies' option, either repair or replace the defective
product with the same or an equivalent model.

C Technologies, however, takes no responsibility for:

1. Damage caused during shipping, by accidents, malicious damage, modification, incorrect usage,
force majeure or any cause beyond the control of C Technologies, including but not limited to
lightning, water, fire, public disturbances, riots, strike, war or other similar conflicts.

2. C Technologies is not responsible for damage (including but not limited to direct or indirect
personal injury, lost profits, fall in production, losses of or alterations to processed information or
any other incidental or consequential damages) caused by the product or the usage of the product
or because the product cannot be used.

3. Deficient maintenance or a repair performed by unauthorized persons.

4. Incompatibility due to technological developments.

5. Defects caused by external equipment or abnormal wear.

6. Defects caused by normal wear and tear.

7. Damage caused by the usage of inappropriate battery.

8. Damage arising in connection with or as a consequence of upgrading with additions to or
alterations of the product, using software or hardware not produced by or approved in writing by C
Technologies.

If your C-Pen product requires warranty service you should return the product to the dealer/retailer from
whom it was purchased. The product must be packed in original packaging or with sufficient care so
as to avoid shipping damage. The original purchaser must be able to show proof and date of
purchase with receipt/invoice from point of purchase in order for this warranty to be valid.

Repair or exchange does not extend or renew the warranty period. Exchanged defective parts become the
property of C Technologies. When the warranty period has expired, the warranty of exchanged/replaced
parts also ceases.

This product is not to be regarded as having defects in materials or function if it must be rebuilt in
order to be modified in accordance with national or local technical safety regulations in a country
other than one that the product was meant to be used in.

C Technologies reserves all rights to the product, its hardware, software and trademark. Whoever buys
or uses the product has no right to alter, disassemble, reverse engineer or in any other way use any part
of the hardware or software in the product, except in the way and for the purposes permitted by law.

This warranty does not affect the purchaser's rights against the dealer arising from the sales/purchase
contract, nor the purchaser's legal rights according to existing, mandatory rules in applicable laws.

If there are no such applicable laws or mandatory rules, the purchaser's rights are limited to those
which are stated in this warranty. C Technologies shall not be liable for any incidental or
consequential damages for breach of any expressed or implied warranty of this product.
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